A

w# CYPRESS

~g@@@p” EMBEDDED IN TOMORROW™

AN205550

F2MC-16FX Family, ROM Mirror

This application note describes the functionality of the ROM Mirror function.
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1 Introduction

This application note describes the functionality of the ROM Mirror function and gives an example.

The ROM Mirror makes the contents of a selectable area of the Flash Memory/ROM available is bank 0x00. This can
be used to make the constants stored in non-volatile memory accessible by 16-bit addressing when using “Small” or
“Medium” memory model.

1.1  Key Features
= ROM Mirror OK, 8K, 16K, 24K or 32K Bytes of any bank from 0xFF to 0xFO.

= RAM/ROM Mirror 32K, 24K, 16K, 8K or OK Bytes of bank 0x01 (External Memory)

2 ROM Mirror

The Basic Functionality of the Rom Mirror Function

2.1 Functionality
When using the “medium” or “small” compiler memory model, data access is done by 16-Bit addressing which saves
code size and execution time. For this reason the lowest program bank 0x00 is used, which represents 64 Kbytes of
addressing space and holds the basic I/O register space and the main RAM.

Constants are located in the ROM (Flash) addressing area. Therefore a 24-Bit addressing would be needed for
access. The ROM Mirror function allows to “mirror” a ROM area to the lower 0x00 program bank, so that a 16-Bit
access also to constants is possible.

There may be some devices which has on-chip ROM of more than 28 KByte. In such cases, the RAM is located in
the Bank 0x01 from address 0x018000 to 0x01FFFF. This internal RAM from bank 0x01 can be mirrored to the
lower 0x00 program bank. The size of this area can be set by the user.

The address space between 0x008000 and Ox00FFFF is used for ROM/RAM mirroring. After Reset the address
space between 0xFF8000 and OxFFFEFFF is mirrored to program bank 0x00 (default).

It should be noted that the wait state limitation while reading Flash Memory (corresponding to the clock speed) is
equally applicable when accessing the constants using ROM Mirror.
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2.2 ROM Mirroring Register (ROMM)
The ROMM consists of the following bits:

Table 1. ROMM

Bit No. Bit Name Initial Value Value Description
0, 0, 0, 0 0xF0 bank is mirrored
. 0, 0, 0, 1 0xF1 bank is mirrored
BS[3:0] 1, 1, 1, 1 0, 0, 1, 0 0xF2 bank is mirrored
4
1, 1, 1, 1 0xFF bank is mirrored
3 - X X Undefined. Please always write “0” to this Bit.

ROM Mirror disabled.

X, X 0 0x018000 — 0x01FFFF isS mirrored to 0x008000 —
O0x00FFFF
0. 0 1 0xFXE000 — OxFXFFFF and 0x018000 —
2 Y 0x01DFFF is mirrored
Sz[1:07], 111
MI o 0xFXC000 — OxFXFFFF and 0x018000 —

o
o
~
"
~
"

0x01BFFF is mirrored

0xFXA000 — OxFXFFFF and 0x018000 —

10,1 0x019FFF is mirrored
1, 1, 1 0xFX8000 — OxFXFFFF is mirrored
0xFX. ... stands for the program bank selected by the BS[3:0] Bits.

2.3 Linker Settings
In order to use, the ROM mirror functionality the following steps needs to be carried out in the project workspace:

m  Set the ROM Mirror Configuration (4.11) in start.asmnfile.
®m  Place the constant (CONST) section in the corresponding Flash Memory area.

m  Define the memory model as “Small” or “Medium”.

After following the above steps, if one of the constant resides at a memory address 0xFE8008, then it is accessed at
address 0x008008. Section 3.1 describes this in details with example.

WWW.CYpress.com Document No. 002-05550 Rev. *B 2



o CYPRESS

- EMBEDDED IN TOMORROW™

F2MC-16FX Family, ROM Mirror

2.4 Memory Allocation Examples

2.4.1 Default

MI = 1; sz[1:0] =1, 1; BS[3:0] =1, 1, 1, 1

Figure 1. Memory Allocation - Default

OxFFFFFF
0xFF8000 ROM
0xFE0000 ROM
0x00FFFF _

0008000 Mirrored ROM
RAM START' RAM
0x000000 /O Area

! Check datasheet for actual address
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2.4.2 Split RAM/Flash Memory Mirror
MI = 1; Sz[1:0] =1, 0O; BS[3:0] =1, 1, 1, O

Figure 2. Memory Allocation — Split RAM/Flash Memory Mirror

OxFFFFFF
OxFF0000
OxXFEFFFF
OxFEAO00O0
OxFEOSFFF
O0xFEO0000

0x019FFF
0x018000

O0xO00FFFF
0x00A000
0x009FFF
0x008000

RAM START'

0x000000

3 ROM Mirror Example

Example for the Rom Mirror Usage

ROM

ROM

ROM

Internal RAM (if
implemented on
device)

Mirrored ROM

Mirrored RAM

RAM

/O Area

3.1 Enabling ROM Mirror using start.asm
The below sample code demonstrates how to enable and use the ROM Mirror functionality.

In this example, it is considered that the constant array [5] needs to reside in the bank 0xFE starting from address
0xFE8000 and the entire area from address 0xFE8000 to address OxFEFFFF needs to be mirrored to bank 0x00.

In order to achieve the same, the following configuration needs to be done in start.asm file:

®m  The define ROMMIRROR needs to be set to ON to enable the ROM Mirroring functionality.

®m  The define MIRROR BANK needs to be set to 0xE to mirror bank 0xFE.

m  Also the define MIRROR SIZE needs to be set to MIRROR 32KB to mirror entire 32KB area starting from

0xFE8000.

WwWWw.Ccypress.com
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start.asm

’

; 4.11 ROM Mirror configuration

’

fset
#set
fset
#set

#set
fset

fset

MIRROR 8KB

MIRROR 16KB
MIRROR 24KB
MIRROR 32KB

ROMMIRROR
MIRROR BANK

MIRROR SIZE

0
1
2
3
ON ; <<< ROM mirror function ON/OFF
0xE ; <<< ROM Mirror bank, allowed entries:

; <<< 0x0..0xF for the banks O0xFO..O0xFF
MIRROR 32KB ; <<< ROM Mirror size

The constant array[5] needs to be defined in main.c.

main.c

const int arrayl[5]

{0x1000, 0x2000, 0x3000, 0x4000, 0x5000};

WwWWw.Ccypress.com
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Then the CONST section needs to be set for the project. This can be done in the “Setup Section” dialog box as
below:

In the “ROM/RAM Area Name” dropdown menu one has to select “Specify in Address”. Then in the “Section Name”,
CONST needs to be specified and then the desired starting address (0xFE8000 in this case). The “Contents Type”
should be “Const” and the alignment as per the requirement. After filling all the information, “Set” button needs to be
set and then press “Ok”.

Figure 3. CONST Section Setting

Setup Section |

BOM/RAM frea Mame: |l e

Section Mame: IEDNST Set
Address: IH'FEEIIIEIEI
Contents Tupe: I Const

L L

Alignment: | BYTE

Section Mame Ligt:
COMSTConst/BYTE=H'FER000 Delete

U

[awm

d

(] I Cancel |

The above dialog box can be reached as mentioned below...

Project -> Setup Project -> Linker -> Disposition Connection -> Set Section
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After setting up the section the “Memory Model” needs to be defined as “Medium” or “Small”.

Figure 4. Memory Model Setting

Setup Project ﬂ

T arget of setting: Generall bMCU T Compiler I.ﬂ.ssemblerl Linkerl Librari 4 I *I

IDEhUEI j Categony: arget Dieper * | Eammar Dptil:lr‘ll

38 =) 95240 flashcan] 00p340.pri

termany kodel:
I b ediumn j

[ Const variable in Bk

Optiar:

9. r

AMF LIST

-0 4 -
q ] =
| k. I Cancel | Smply |

The above dialog box can be reached as mentioned below...

Project -> Setup Project -> C Compiler -> Category -> Target Depend -> Memory Model

Once all the above steps are carried out, then the project can be build.
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After building the project, in order to confirm that the CONST section is mapped correctly to the desired bank 0xFE,
one can right click on 96340_rom_mirror-vl0.abs. Then in the popup window go to Open List File ->
96340_rom_mirror-v10.mp1l.

= SOFTUNE Workbench - 96340_rom_mirror : Debug - [Main.c]
] Fle Edt Wiew Brojsct Debug Setup Window Help

Figure 5. Opening Map File

LI
e

Emlwleol #l ol =lz=E)

EEEE]

[36340_rom_minor ~][Debug

D@ (2] e &Rl = =

SN =

=81 workspace'96340_rom_mirror’
96340_rom_mirror-y10.abs - “9634(zxg
=43 Source Files

Main.c

~[F) mboe346rm, asm
[ readme.kxt
~[F) Start.asm
wectors.c

(23 1nclude Files

=128 Dependencies

~[B mhoe3d6m.h

=3 Debug

~EM MEZ198-01_COM1.sup
EA MBZ198-01_COMZ.sup
-[@ MEZ198-01_USB.sup
[ Simulator sup

52t Active project
Create new folder...

Add Member ko project » |
: int templ, tempZ:
2

Set Proet...
Set Linkage order..

Make
Build

Exeuting linker or lbrarian
Delete Prajest:

Property.

Open List File
Open HEX File »

SRC

1l:
| ¢ #include "mb96346rw.h"”

1 const int array[5] = {Ox1000, 0x2Z000, Ox3000, 0x4000, Oxs000};

*/
JF====== MAIN wy
*/

: void main(void)

E

InitIrglevels():

1 65D400FE CALLP

_set i1(7]:

+ 1aa? HOV

SEE40_ran_rirrar-v 10,
96340 o _ritrar-v10.mps

vInitlzglevels
#/ allow all levels
LM, #07
#/ globally ensble interrupts
CCR, #40

96340 o _mirrar-v10,mpm 1,8000
: 4242,4
tempz = array[1];
: 5ANZB0 HOVW  A,B002
: 5BAD4Z HOVW 4240,4
/% initialize the LC display */
66 FETF

WwWWw.Ccypress.com
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Then the map file 96340_rom_mirror-v10.mpl would be opened as below. As highlighted in the figure, CONST section
starts from 0xFE8000 and ends at 0xFE8009. The section is 10 bytes long since the constant array is of integer
type and has 5 elements.

Figure 6. Viewing Map File

= SOFTUNE Workbench - 96340_rom ebug - [96340_rom_mirror-v10.mp _18] x|
") Fle Edit Wiew Project Debug Setup  Window Help =18 x|

mlelelelol @l =oF =z
EEEE]

[36340 rom_minor _][Debug j|
D[e(E] 558 oo &lalwlw == =
@Y Workspace'96340_rom_mirrar’ wal' . L . L L L . L . S|
96340, i -v10.abs - “96340 i |
=B _tom Tirror-¥10-a% -LOM._Mirror-pr 41|BF2HC-16 Family SOFTUNE Linker Mapping List 2007-1
(=3 Saurce Files 2 J
“ ME'“‘E 43|S_Addr. -E_addr.  Size section Type Al sec.(Top 81)
mbI6346rw. 3sm 44| GBOBO00G-000POOES 0AAOBOE7 10 RU-— 00 ABS 10BASE
+L) readme.bxt 45| 00000100-0000012F BAAGBB3A DATA N RW-- 08 ABS DHADESCRIPTOR
) Start.asm 46| 0000O180-0000018F BAAOBE1A DATA N RW-- 81 ABS Register Bank No. 89
- vectors.c 47| 0000P3IBO-000BOBCD BBAGBBSHE DATA 88 ABS  10XTHD
(23 Include Files 48| 0ONB4240-00004243  BBAGBEGH DATA 82 REL DATA
-4 Dependencies 88088608 DIR 82 REL DIRDATA
@ mbo6346re.h ... 0000BBOA DIR 82 REL DIRINIT
148 Debug 51| 80064214~ ... ©BBOOBBOA DATA 82 REL DATA2
- MBZ196-01_COMLosup 52| pORBA2 Y- ... ©BBOOBBOA DATA 82 REL LIBDATA
B ME2190-01_COM2.5up 53| 000642 LA~ ... ©B0OOBBOA DATA 82 REL INIT
e p— 54| BOOBLZ LY~ ... ©B0OOBBOA DATA 82 REL INIT?

... DbOooBaeAd DATA
000008080 DATA
57| 000084244, ... 000008080 DATA

N
N
N
H
P
P
P
P
P
P
P
P 62 REL LIBINIT
P
P

53| D0004ZL44-00DO4SLE  0000D300 STACK P
P
H
H
H
H
P
P
P
P
P
P
P
P
p

82 REL CINIT

82 REL CINIT2

82 REL SSTACK

82 REL USTACK

00 ABS HAIN_SECURITY
80 ABS HAIN_PROTECT
80 ABS BOOT_SELECT
80 ABS UART_SCAN SELECT
81 REL CODE_START

81 REL CODE_main

81 REL CODE_vectors
82 REL DCONST

82 REL LIBDCONST

82 REL CONST2

[ Simulator sup

59| 00064544-00004545 06006602 STACK
66| 0ODF 0006-0ODFOG1B GOOO6B6E1C CONST
61| GODF 0O1C-00DFO02F 06006614 CONST
62| 0ODF 0030-00DFO033 0006604 CONST
63| 0ODF 0034-00DFO03F GOOOGEOEC CONST
64| OOFEPOOP-0OFEQGBE GEOOBGEF CODE
65| GOFE BOBF-0OFEQGD3 66006615 CODE
66| GOFE 0OD4-0OFEQGFA 6086627 CODE
66006688 CONST
66006688 CONST
66006688 CONST
76| OFEGOFC-OOFEQ16D 06006612 CONST 82 REL DCGLEAR
71| 0DOFEO10E-DOFEO13F  0OOOOO3Z CONST 02 REL DTRANS

72| DOFE 140 DIRC 82 REL DIRCONST
73 OOFES00P-DOFES00? DOOOOOOA CONST P 02 REL _CONS
74| DOFFFEQC- D1 BS INTUECT

75| 0OFFFFDC-OOFFFFDE 00000083 CONST N R--I 00 ABS RESUVECT

76 |WF2MG-16 Family SOFTUNE Linker Symbol List 2e87-1
7
78|Symbol Ualue Type Def. Symbol Hame (Top 97)
79| BOFEQOF5{ABS) Addr. OM/LM @ DefaultIRQHandler
4 | | _l_I
sl [ [ [
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In order to confirm that the ROM mirroring is got configured correctly, in the memory window bank 0xFE and bank
0x00 can be viewed. The following figure shows that word data of the first five locations of bank 0xFE (0xFE8000 -
0xFE8008) are exactly matching with those of 0x00 (0x008000 — 0x008008).

Figure 7. Bank OXFE Mirror to Bank 0x00
18] x|

@ Fle Edt Wiew Project Debug Setup Window Help =181
Blmlwlelsl # 2o slEsal

& |

[96340_rom_minor = ][Debug =l

DIS|E| plE(e] olc] &bl = e

ddress +0 +2 _+4 _+6  +8 +h +C +E +l0 +lz +14 +16 +18 +lA +IC +1E Ascii

IFEG000 EEB ADEAR 774D 6880 42A8 20C6 SDCE B521 2BFS F463 C175 ... .D.E.P....Hm 9 NI T
FES020 1226 UDYZ BT43 8208 CO7C 0C46 5660 5125 7627 6AAF BeET ASCA EATS 04LD 05D2 C83D +.. CLFLWEQ w03, .
[FEG0an @804 16 zA2C ESC7 2528 3074 7FEAF 7060 S0k 3EBZ DFED SA2A 4142 DA23 FEBA TCF3 ....,*..)sz0.-p.P.>m. *ZBAd..

Ay r— [sddress +0 +2  +4 +6 48 +A 4L +E  +l0 +12 +14 +l6 +18 +lA +LC +lE Ascii
D) roadmo.bxt UE000 QU000 3000 4000 SUUD-PSCE ALEA T740 5850 4ZA8 ZOCE SDCS ESZL 2BFS F4S3 C1TS ... .U.@.P....Hw.h.B. I
B start.zam 00020 ET4Y TO7C 0C46 5660 5125 7627 6A4F BEET ASCA EA79 041D 0SDZ C83D +...
turen 008040 5804 16C6 2A2C ESCT 2529 307A 7EAF 7060 S0LA 3ESZ DFED SAZA 4142 0AZ3 F6B4 7CF3
' 008060 0CBT 62D1 AF3F 7CDA SCAE 9B0S 7E4A AFCD 130D EO6S D873 BOSE ECSA 599D 45FA 0DOC
3 Include Files 008050 152D 40FS 933D E6DY AATC 0448 7361 24ES 535D LS6E SE4E DD3Z 26Dl 8551 3LED 7250
=E8 Dependencies D0B0AD  AASC 8804 D56C DOB4 2558 94FD E761 42E6 013 CFlA 0731 EF2Z3 1FLS 093D 77CF F2C7
B mboe34gren 0080C0  0OAS 1040 B719 9257 DDFL ED6F BELL 3009 4C08 A0S SECE 8195 EA4OB B194 0DCA 9273 ..
= /&8 Debug 00S0E0  E3FD 4074 06ZE 170A 35325 1439 5C21 DD39 BZLS FAOL 47DE DAOE 48DD 5907 DAEF 5764 ..
Efl MB2198-01_COML sup 005100 4EB3 3005 B0SS FEOD E340 3000 SE48 BDFZ 0232 6735 E4CD A930 20EL 80A0 DT7D 2071 .K.
-t MBZ138-D1_COM2.sup 008120 1D1L 0268 A§73 EODE 3CS1 C53B DEDZ 6221 6CF6 2134 63EF 220h FACE SDTB 7LFD S06E ..h.
MEZ198-01_USE.sup 008140 6615 15E3 36AA 37DD 182E ASEB 954E 3CSD ESCF 06B7 GCAE 34C4 8053 10A9 9A4D BGCE .
- Smulator.sup 008160 8D85 FIBF 266D ABBS 4139 C2EL 4AAB 84D9 496E 3009 27DB OBES 1012 860F FFCH 115C
008150 CBAF 5500 ADOF F77A 4055 7802 E4ES ASFE EF6L 98C2 C3ES 93CE 5935 F190 93E8 7BO3
0081A0 0EBO 5303 DADF 9734 5984 D621 2A76 FZEF 21F4 ESDE E1AD 3151 9080 84BF 60D0 82C4
008100 0SDD A728 EDEC 6BDC SB68 22F0 DFC3 3ABE 5082 FADS 7DEZ 971E S5C5 E623 57CL ASDF
0081E0 2245 570A 4287 B657 2DED z1D7 DDAS DCD3 A006 SESL EFIE 1998 SD03 A3SE ED4S 63E0
008200 D812 9062 AFLE E757 SAE4 E346 AEZD FDFS 2408 5089 0B0S 7A60 4724 8009 OLAB FIE3 .
008220 140 DSBS 67F1 537D DFO3 BOED CA46 ECEA 8A49 51A3 3AFS ESC4 §885 A0SS D204 COF9
008240 9545 E916 F668 FCID 3AE? 6CSC 15C3 67D9 F84B 7532 ADAT 707F 5362 286D 41E4 AFE4
008260 49F5 E849 COEB A3D3 CFBA F704 FSEZ BEEB 03C9 163k C2E3 77EB ZAB9 8601 DG2F FCEB .
008250 309C 220E FSDD 937F DAL 731B 4EOC 9339 EOFL DE33 1176 55DA ZCC2 EDSO ED7L B840F .
0082A0 0861 COO8 4278 EBDD E948 79DE 6C59 CFBO F048 C21C 93CD SE7C 626C A791 F355 2748
008200 7203 8908 6EDT 83EF CE23 41EB 1B47 FDFE 3089 2112 360D F6FB 02ED BEES C6C7 EAGC
0082E0  SE6F 5AD4 DEAS 6FAT 287D 146B DA77 D782 BCAD A756 ZEFS 6C3A SE61 704D FA3D FA3C
008300 2DBL 9A20 CC51 97C5 5000 SCES 45A9 42A9 5863 1221 9FCZ ECS6 47E3 7047 8654 3277 .
008320 3EBC AD7A CDD F774 20EF Cl88 44F3 9F17 S0C 32A0 67B6 3676 SALF 404D 073A E227 .
005340 6019 0DO4 46ZC 71EE C2BS E440 3356A 0EZ6 7ACT AAG4 E6ES 6FB4 069E 5SDE0 4346 78&8C . °
008360 7200 4C18 62F8 §4EL 62A4 6211 2C38 406B 6CAL AS38 6870 DCD1 GBEZ 188E EACA 0246 .
008380 C3D2 58B0 4983 G5ED ECZZ CE6A 3835 1BE9 6921 BFBL C2DF ED13 COAF 09F2 269E 52EZ
DOS3A0 FAZ7 3213 CEFE BE30B EFAZ 1448 ABLF DDDA OC6B DOSL 513D SAD1 48975 3AD4 ESZA 3F6F
DOS3C0  2ZC7 4001 AF7E 41C4 6E1l 6FD4 8DO3 AdD6 2ZDS1 CDS? BEGO FSFF DCOO SEC4 EBE73 GEE4 .
DOS3ED  EGFD 2701 C1B2 DEBS E442 FIC9 14D7 D39E 4272 E202 8BIC 671E 4573 SA85 AEFF Fis9 .
<| I _,I 008400 23E1 0670 523F 709A SEAF 1A3E DCVE DCZF 86A6 S8BC DEZ26 BS79 CBES ZE70 F351 BSEE . .
008420 O0ESO S1BA D7CS B129 0412 6570 5461 EBC4A B934 75D5 BSOC DDEE ASIC CO48 0824 E1AZ P..(..)...piaT..d..u... L
008440 4EZ5 SAS0 Af44 CB47 0168 D545 DALE DBEE SC8D S3FC 9C79 BSCO 3DDC 03D2 3ESC 2892 sN..J.G.h.E...... L1 . T ) LI

@) Workspace'36340_rom_mirrar’
=B 96340_rom_mirror-v10.abs - "96340_rom_mirror.pr
=23 Source Files

I3 EV T

p.P.5n. “ZRAY.
.e.5...L. . TLE..

SRC

The Memory window can be reached as mentioned below...

View -> Memory -> Desired Start Address

4 Additional Information

Information about Cypress Microcontrollers can be found on the following Internet page:

http://www.cypress.com/cypress-microcontrollers
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circuit described in this document. Any information provided in this document, including any sample design information or programming code, is
provided only for reference purposes. It is the responsibility of the user of this document to properly design, program, and test the functionality and
safety of any application made of this information and any resulting product. Cypress products are not designed, intended, or authorized for use as
critical components in systems designed or intended for the operation of weapons, weapons systems, nuclear installations, life-support devices or
systems, other medical devices or systems (including resuscitation equipment and surgical implants), pollution control or hazardous substances
management, or other uses where the failure of the device or system could cause personal injury, death, or property damage (“Unintended Uses”). A
critical component is any component of a device or system whose failure to perform can be reasonably expected to cause the failure of the device or
system, or to affect its safety or effectiveness. Cypress is not liable, in whole or in part, and you shall and hereby do release Cypress from any claim,
damage, or other liability arising from or related to all Unintended Uses of Cypress products. You shall indemnify and hold Cypress harmless from and
against all claims, costs, damages, and other liabilities, including claims for personal injury or death, arising from or related to any Unintended Uses of
Cypress products.

Cypress, the Cypress logo, Spansion, the Spansion logo, and combinations thereof, WICED, PSoC, CapSense, EZ-USB, F-RAM, and Traveo are
trademarks or registered trademarks of Cypress in the United States and other countries. For a more complete list of Cypress trademarks, visit
cypress.com. Other names and brands may be claimed as property of their respective owners.
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